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  Winnie Frost…….……...……….….….  Treasurer 
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  Dorothy Sutherland…...…..………...Membership 
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  Robin Seidenberg…...………..….Public Relations 
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The L.C.A.C.E. News Journal is published eleven 
times annually. Members are encouraged to submit 
contributions and will be acknowledged in this 
newsletter. 
 
Permission is granted to reproduce any or all parts of 
this newsletter in other User Group publications, 
provided that credit is given to LCACE and the 
individual author(s).  
 
The News Journal is produced using a Dell Dimen-
sion 2400, Dell Printer, and MS Publisher 2003 
software. Graphics editing and artwork provided by 
Pegasus Enterprises. Photos taken by Various 
digital cameras and Adobe Acrobat Pro 6.01 for PDF 
conversion. 

Lake County Area Computer Enthusiasts 
LCACE 

c/o Group Ambassador 
409 S. Elmwood Ave. 

Waukegan, Illinois 60085-5219 
 

Membership 
 

Membership for LCACE is open to all individuals and 
families interested in personal computing. Annual dues 
are $20.00 per individual/family. Associate membership 
is only $10.00 (out of state, unable to attend meetings). 
Membership includes a one year subscription to the 
L.C.A.C.E. News Journal and access to all club libraries 
and functions. Applications for membership may be 
obtained at the monthly meeting, by request on the club 
Hotline, and are now available on our WEB site at  - 
http://www.lcace.org. 
 

Meetings 
 

LCACE meetings are usually held on the second Satur-
day of each month at the Grayslake Area Public Li-
brary, 100 Library Lane, Grayslake, Illinois. The meet-
ing room opens at noon and  the formal meeting begins 
at 12:30 p.m.  All meetings are open to the public.  
Bring a friend! 
 

Advertising 
 

Ad rates per issue: Full page - $25, Half page - $15, 
Quarter page - $10, Business Card - $5. Discounts are 
available on advance purchase of multiple issues. Please 
send camera-ready copy and payment to the club ad-
dress by the 21st of the month preceding publication. 
For more information on ad pricing, please call our Hot-
line. Ads are FREE to all paid members. 
  

Notice 
 

LCACE WILL NOT CONDONE  or knowingly partici-
pate in copyright infringement of  any kind. The 
LCACE News Journal is published by and for LCACE 
members. Opinions expressed herein are those of the 
individual authors and do not necessarily reflect the 
opinion of LCACE, the membership, the Board of Di-
rectors, and/or our advertisers. 

“Members Helping Members” 
(since 1983) 
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Digital Corner 
 
Submitted by “JJ” Johnson 
Nikon School 
learn new ways to look at things 
 
The Nikon School will be coming to our area with their 
2005 program.  Nikon School offers three courses that 
cover a wide range of technical and creative territory. 
Shooting Digital is for the amateur and advance amateur 
photographer and will help you get that great shot. Digital 
101 is for the new digital camera owners and anyone con-
sidering digital photography and Digital 201: Workflow 
Techniques gives advance digital photographers making 
the transition to digital SLR cameras. 
Nikon School of Photography: Shooting Digital ($119) – 
June 11 or 12, 2005, Nikon School: Digital 101 ($119) – 
April 16, 2005, and Nikon School Digital 201: Workflow 
Techniques ($149) – April 17, 2005. All sessions are 
scheduled from 9:00 a.m. to 5:00 p.m. To register call631-
547-8666 or online @www.nikonschool.com. 
 
Adobe Photoshop Seminar Tour 
The Photoshop CS Creativity Tour is coming to Donald E. 
Stephens Convention Center in Rosemont (O’Hare),  
IL.  on Monday, April 25. Spend a day with the photo real-
ist genius Bert Monroy, and learn Layers: Beyond the Ob-
vious, Channels: More Than What Meets the Eye, Master 
Class: Brush & Pen Techniques, Pen Tool & Filters: 
Unleashing Your Creativity. 
Admission to the Photoshop CS Creativity Tour is only 
$79 for members of National Association of Photoshop 
Professionals (NAPP) or $99 for non-members. 
Secure your spot now by calling (800) 201-7323, Monday 
– Friday 8:30 a.m. to 7: 00 p.m. EST or online @ 
www.photoshopseminars.com 
 
 Digital Video Workshop: Shoot & Edit Great Video 
Learn digital video basic and create amazing movies on a 
desktop computer. 
This is an online course from Help.com that started on 
March 31, but it is not too late to signup and catch-up. 
 
Adobe Photoshop Basic 
With Adobe Photoshop 7, you can do pretty much anything 
you want to your digital images. This is another FREE 
course from www.help.com  and also started in March, but 
sign up and get started. If you do not have Photoshop 7 and 
are using Photoshop Elements, this course will also get you 
lots of insight as to what you can accomplish with Photo-
shop Elements. 
 

 

Check Your PC Lately??? 
 
By J.Rutledge 
 
Have you had a little problem lately with the PC?  Is it a 
little on the slow side?  What about performance?  Do 
you get errors?  How about a little check list to make that 
computer run better? 
 
DESKTOP CLUTTER- How many of you have more 
than fifty icons on your desktop?  All those icons can 
really slow your computer.  Most of them are programs, 
not short cuts.  If this is true for you, then take the unused 
icons and make a folder on your desktop and dump them 
in there.  Abracadabra.  Speed again. 
 
UNUSED PROGRAMS- Why not trash those programs 
that you have been holding onto like grim death?  Espe-
cially if they are on your desktop.  Drag and drop them to 
your recycle bin.  That way, if you need them, there they 
are after you restore them. 
 
UPDATE VIRUS CHECKER- If you haven’t been up-
dating your virus checker, shame on you.  Viruses are a 
major problem when your pc slows down. 
 
USE THE BROOM- Use your disk cleanup in the system 
tools folder under accessories.  That will help you, too! 
 
USE SPYBOT- Spybot Destroy is one of the best clear-
ing software for pc’s.  It will isolate files such as cookies 
and spyware.  Then, all you have to do is delete them. 
 
DISK DEFRAGMENTER- Use disk defragmenter under 
properties for hard drive letters.  It will put files in a 
place on your hard drive where it is easy to access. 
 
GET INTO A ROUTINE - If you pick a day either of a 
week or month, just sit down and take care of your com-
puter.  You will notice a difference. 
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Places4Aces 
 
web)Sites4Soaring ah 
 
PLACES4ACES (web)sites4soaring ah's  
 
Stay Tuned. 
 

Member of the Month 
 
 
 
 

CANDIDATE CORNER 
 
Linda Busch: She has been a member since 1998.  She has served 
as Secretary and is currently in her fourth consecutive term as 
President.  She  "personed" the L.C.A.C.E. booth at the Computer 
Country Expo for the past five years.  She is also the assistant 
editor for the News Journal and serves on the Holiday Party com-
mittee.  
 
Michael McEnery: has been a member since 1985.  Mike has 
served the club as Disk Librarian, Newsletter Editor, and Vice 
President (five terms). For the last two years, he has organized 
the Holiday Party and  been the Beginners SIG Leader.  
 
Winnie Frost:  She has been a member since 1998. Winnie has 
served one term as Club treasurer, and has done an outstanding 
job of keeping the club finances on track.  
 
Dorothy Sutherland: Has been a member since 2003. Dorothy has 
served one term as Membership Chairperson. During the meet-
ings she  cheerfully greets members and guests. As Membership 
Chairperson she is responsible for signing up new and renewing 
members as well as handling the monthly 50/50 and door prize 
raffles.  
 
Robin Seidenberg: Has been a member since 2002. During her 
two terms as Public Relations Chairperson, Robin has ensured the 
Club has been well promoted in all the local newspapers. Robin 
was also instrumental in gathering the abundance of prizes for the 
2004 Holiday Party.  
 
Jim Rutledge: He has been a member since 1998. After joining 
the club Jim has held the Vice President, Program Chairperson, 
Secretary and Newsletter Editor positions. For the past five years, 
he has helped man the Club booth at the Computer Country Expo 
and served on the Holliday Party Committee. He is known as the 
Club's resident Guru and Network guy.  
 
J.J. Johnson: He is the founder of L.C.A.C.E. and  has served two 
non-consecutive terms as President. J.J. has also served as Treas-
urer,  Public Domain Disk Librarian and Newsletter Editor for 
more than ten years. .He is  presently the Webmaster and presides 
as SIG leader for Digital Corner. For the past twenty-two years 
he has served a member of the Board of Directors.  
 
Lester Larkin: He has been a member since 1986. Lester has 
served several terms as  public relations and membership chair-
person. After a short relocation to Florida, Lester has returned 
and is offering to serve the club again. 
 
Zack Gilbertson: (Junior board nominee) Zack has served one 
term as assistant program chairman and has dazzled the group 
with his informative Windows utilities presentations.  

My Job is: Securities Trader 

Family: Nancy (wife) 

Hometown: Mundelein, IL 

For Entertainment I Like: Tennis & Riding my on/off road 
motorcycle and watching TV. 

A book or movie I would recommend: The Bible 

My favorite meal would be: 2 chocolate sundaes 

My prized possession: Health 

Someone I admire: Jesus Christ 

I wish I could stop: War, Hunger, Injustice and Crime 

I want people to remember me: when they are making out 
their wills 

I use my computer for: Making and managing money 

My favorite computer program is: Open Office 

My favorite phrase or expression is: "Buy Low, Sell High" 

Lester Larkin 
  

Birth Month: July 
  

Member since 1986 



 

Page 5 

Featured Articles  
February 2005 • Vol.16 Issue 2  
Page(s) 64-65 in print issue  
 

How To Install Device 
Drivers  
Let Them Get Behind The Wheel Of Your 
Hardware  
 
 
You can't make a vehicle move simply by filling its tank 
with gas or sticking a key in the ignition. If you want it to 
go somewhere, you first must slide behind the steering 
wheel and take control.  
 
The same holds true for computer hardware. Without a 
driver (software that helps hardware components commu-
nicate with the rest of the system) telling it what to do, the 
component will not function as it should. You must learn 
how to install and update these vital pieces of software to 
ensure that you're getting optimum performance from your 
PC and its components.  
 
 
 
 
 
 
 
 
 
 
 
The Add New Hardware Wizard, which may be labeled as 
the Found New Hardware Wizard or the Hardware Up-
date Wizard, depending on how you access it, helps you 
install new drivers for system hardware  
 

Drivers Wanted  
 
Fortunately, the most recent Windows editions come bun-
dled with libraries of drivers that support basic functional-
ity in the most common hardware devices. As a result, you 
can plug in a new piece of equipment and reasonably ex-
pect that Windows will be able to support it.  
 
But just because you can take advantage of the Windows 
drivers doesn't mean you necessarily should. The proprie-
tary driver that comes packaged with a particular device is 
designed to handle everything the device is capable of do-

ing. For this reason, we encourage you to use proprietary 
drivers if possible. Such drivers are typically packaged with 
the installation CD-ROMs (or in a few cases, floppy disk-
ettes) that accompany hardware components. Refer to the 
product's setup guide to determine whether the installation 
software includes a driver. If you purchase a device that has 
no accompanying installation software, you must use one 
of the drivers that came bundled with Windows.  
 
Installing a driver for a new device is a relatively painless 
procedure. The initial step is to read the hardware installa-
tion instructions completely. Doing so will familiarize you 
with the installation procedure and, more importantly, tell 
you when to install the driver. In some situations, you may 
be required to install the driver before you install the hard-
ware. Always follow the installation instructions to the let-
ter.  
 
In most cases, Windows will automatically detect the pres-
ence of new hardware and present the Found New Hard-
ware Wizard. If you're installing a proprietary driver from 
installation media, refer to the users manual to determine 
whether you should close this wizard and use the accompa-
nying driver installer instead. If the installation instructions 
prompt you to use the Found New Hardware Wizard or if 
you don't receive any installation instructions at all, click 
the wizard's Next button to start the driver installation. The 
wizard's instructions will vary depending on which OS 
(operating system) you use, but the process is generally the 
same across the board.  
 
First, specify whether you or Windows will select the 
driver. It's usually best to let Windows handle this responsi-
bility. Simply insert the installation media, if available, in 
your computer and opt to let Windows locate the driver. 
The wizard will scan your system for the presence of a 
compatible device driver and identify the appropriate 
driver.  
 
If the wizard can't find an appropriate driver, it will ask 
whether you want to cancel the installation or go back so 
that you can specify where the driver is. If you decide to go 
back, you typically have the option of designating the 
driver's location or selecting the driver from a list of possi-
ble options. In the latter case, you should follow the 
prompts to designate the type of device involved and click 
Have Disk to locate the driver on the installation media. 
Follow the on-screen instructions to install the driver.  
 

Moving Forward  
 
The rapid pace of change in the technology industry dic-
tates that drivers are often out-of-date before they're even 

(Continued on page 6) 
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installed. The driver may lack support for a new feature, for 
instance, or conflict with another product that has more re-
cently come to market. That's why you should take advan-
tage of Windows Update, which can deliver Microsoft-
certified third-party driver updates directly to your PC. It's 
also why you should visit the device manufacturer's Web 
site as soon as your hardware is up and running—and peri-
odically after that—so that you can obtain downloadable 
driver updates.  
 
To download a driver update, visit the manufacturer's site, 
look for a link labeled as Downloads or Drivers, and peruse 
the resulting options for a driver that works with your par-
ticular component. Follow the on-screen instructions to 
download the driver to your PC. You also should print the 
driver installation instructions, if available.  
 
Downloadable drivers often arrive as compressed files. Ex-
tract the file's contents to a diskette, a recordable disc, or a 
folder on your hard drive. If you download a driver from a 
reputable manufacturer, it will probably come bundled with 
an automated installer program. With an installer, a driver 
installation is as easy as double-clicking the downloaded 
file and following the on-screen prompts. If you download 
a driver from a third-party site, however, you may have to 
install it manually. This isn't as bad as it sounds, especially 
if you take advantage of a driver update wizard.  
 
You can access a driver update wizard through the Device 
Manager. To open the Device Manager, right-click My 
Computer and select Properties. When the System Proper-
ties dialog box opens, either choose the Device Manager 
tab (in Windows Me and Windows 98) or choose the Hard-
ware tab and click the Device Manager button (in Windows 
XP). A list of installed hardware devices will then appear 
on-screen. Double-click the device you want to update. On 
the Driver tab of the resulting dialog box, click the Update 
Driver button and follow the on-screen instructions to com-
plete the installation.  
 

Driving Into The Sunset  
 
Hardware upgrades involve an investment of effort, money, 
and time. Make the investment pay off by keeping the hard-
ware drivers up-to-date. Outfitted with the latest drivers, 
your system components will deliver optimum performance 
with minimal problems long into the future.  
 
by Jeff Dodd  

PC Today Cover Stories  
December 2004 • Vol.2 Issue 12  
Page(s) 48-49 in print issue  

Navigate Outlook 
2003  
Check Out What’s Different From Previ-
ous Versions  
Outlook received the lion's share of interface improve-
ments in Microsoft Office 2003. The ubiquitous business 
email and scheduling program might seem a little more 
confusing at first glance, but click around, and you'll find 
some nice options for better organizing the information 
that keeps you on track.  

The Big Picture  
 
The left side of the Outlook window, where you probably 
were used to seeing the shortcuts menu or a list of your 
various folders, now features the new Navigation Pane. 
You can toggle the Navigation Pane on or off by pressing 
ALT-F1 or selecting Navigation Pane in the View menu. 
The Navigation Pane is broken into two sections. On the 
top is a list of shortcuts, commands, or other tasks that 
change depending upon what element of Outlook you dis-

Copyright 2005© Sandhills Publishing Company. All 
rights reserved. Sandhills Publishing retains all copy-
rights in all text, graphic images, videos, code, and 
software owned by Sandhills Publishing 

(Continued from page 5) 

(Continued on page 7) 
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play. At the bottom of the Navigation Pane, you will find 
oversized buttons leading to Outlook's various sections.  
 
The Navigation Pane is context-sensitive, which means it 
displays different commands depending on which element 
of the program you are using. Click the Mail button, and 
the Navigation Pane fills itself with all mail folders on the 
bottom and a selection of shortcuts to favorite mail folders 
on the top. Click the Calendar button, and small monthly 
calendars take over the Navigation Pane. For the Contacts, 
Tasks, and Notes buttons, the Navigation Pane provides 
quick access to View commands that formerly required 
multiple clicks to find.  
 
The last button by default in the Navigation Pane is Short-
cuts. The Shortcuts Pane features one-click links to Out-
look Today and Outlook Update. Outlook Today is the 
same summary of Outlook data found in previous versions, 
including upcoming events, tasks, and a running total of the 
unread messages in your inbox. No changes here. Outlook 
Update is merely a link to the Microsoft Office Download 
Center Web page.  
 
It's easy to add shortcuts and groups of shortcuts using the 
two links at the bottom of the Shortcuts Pane. Shortcuts can 
lead you to any folder within Outlook or to non-Outlook 
files stored elsewhere on your drive or a network drive. To 
add a non-Outlook shortcut, just drag a file, folder, or drive 
icon to the word "Shortcuts" at the top of the pane. If you 
customized your shortcuts list in a previous version of Out-
look, that list should migrate automatically to the new 
Shortcuts Pane.  
 

If the Navigation Pane just isn't for you, a new Go menu 
provides a fast way to switch from one pane to another. 
Users who find the Navigation Pane takes up too much 
valuable screen space can instead click Go and choose any 
one of Outlook's various views. If you'd rather use the key-
board, the Go menu lists shortcuts (such as CTRL-1 for 
Mail) that will whisk you to any pane you choose.  

Email Central  
 
Email is the heart of Outlook, and Office 2003's designers 
concentrated their efforts here. Click the Mail button in the 
Navigation Pane to see Outlook's new system. You can ac-
cess all your email folders through the hierarchical folder 
tree under the All Mail Folders heading. Favorite Folders at 
the top is reserved for links to email folders that you access 
on a regular basis. To add a folder to the Favorite Folders 
section, right-click the folder under All Mail Folders and 
select Add To Favorite Folders. You can add folders and 
virtual Search Folders to the Favorite Folders section to 
easily locate the views you use. (Refer to the "Track & Or-
ganize Email" article on page 50.)  
 
If you are one of those Outlook users who used the Preview 
Pane to read email messages in older versions of Outlook, 
you will appreciate the Reading Pane, which takes over 
where the Preview Pane left off. To toggle the Reading 
Pane, open the View menu, select Reading Pane, and 
choose where you want the Reading Pane to appear. By 
default, the Reading Pane shows up on the right side of the 
screen. Depending on your monitor and resolution settings, 
it might make more sense to move the Reading Pane to the 
bottom of the screen.  
 

(Continued on page 8) 

(Continued from page 6) 
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May 
Renewals 

Lee and Mary Nordstrom 
Grace Vogt 

Zack Gilbertson 

 The Reading Pane gives you a quick look at the contents of 
whatever message you selected in the main mail list. In an 
office setting, you can respond to meeting requests and 
click voting buttons right in the Reading Pane without actu-
ally opening the message. As with the old Preview Pane, 
viewing items in the Reading Pane can cause their status to 
change from unread to read. To control this function, open 
the Tools menu, select Options, and click the Reading Pane 
button under the Other tab.  
 
Outlook displays message information in the main window 
on single lines, like in previous versions, or on multiple 
lines when screen space is in short supply. For example, the 
Navigation Pane and Reading Pane might scrunch the mid-
dle pane. Instead of hiding columns, Outlook displays the 
most important fields, such as the sender and subject, on 
different lines. If you don't see the column you need, hover 
over a message with the mouse, and a ScreenTip with the 
information will appear.  

Arrangement Options  
 
Another key to navigating the new Outlook is to experi-
ment with email arrangements. Arranging email in a folder 
view does not actually move any messages around; instead, 
Outlook displays them in different ways so you can quickly 
zero in on important messages in a large batch. Outlook 
starts with 13 built-in arrangement options; click the Ar-
ranged By column heading at the top of the message list or 
open the View menu and select Arrange By to choose from 
them.  
 
One arrangement that sounds more useful than it ends up 
being is the Conversation option. This selection groups 
messages according to their subject lines, which would 
work better if Outlook stored all messages in a single 
folder. Because incoming and outgoing emails are kept in 
different folders, arranging by conversation in any particu-
lar folder necessarily leaves out many of the messages. 
Combine this arrangement with an appropriate Search 
Folder, and you might be on to something.  

Set The Date  
 
Strolling through Outlook's Calendar is a bit easier in the 
new version. Because the monthly Date Navigator calen-
dars are displayed in the Navigation Pane, a particular date 
in the near future is just one click away no matter which 
type of calendar you're viewing in the main window. If you 
remember and like the TaskPad view instead, open the 
View menu and choose TaskPad.  
 
Just below the Date Navigator section are checkboxes for 
turning on and off views of other calendars accessible to 
your machine over a network. The Share My Calendar link 

lets you share your appointments with co-workers, and an 
Open A Shared Calendar link makes it simple to add 
someone else's date book to your own.  

Customize Your Contacts & Tasks  
 
Contacts and Tasks include revamped Navigation Pane 
areas where you can select different views from the Cur-
rent View list. Rather than dig through menus to find the 
most convenient way to list items, a series of radio but-
tons puts all of the built-in views front and center. Click 
each button to see which one works best for particular 
situations. Click the Customize Current View link, also in 
the Navigation Pane, to tweak an existing view to fit your 
needs.  

Keep Your Eyes Open  
 
Keep an eye on the Navigation Pane, and you will pretty 
much always know where you are in Outlook and how 
you can alter the current view to find the information you 
want.  
by Alan Phelps  

Copyright 2005© Sandhills Publishing Company. All 
rights reserved. Sandhills Publishing retains all copy-
rights in all text, graphic images, videos, code, and 
software owned by Sandhills Publishing 
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As much as we try, we do make errors. Please advise us if 
there is a mistake in your E-Mail address or if it is not in-
cluded in this listing.  Send E-Mail to Ms. Dorothy Sutherland 
at membership@lcace.org with the additions and/or correc-
tions. Thank you. This listing last updated February 28, 2005 

L.C.A.C.E. HOTLINE 
 

Call: 847.623.3815  
 

 Web Site:  http://www.lcace.org 

If you have a 
Web Site 

and would like to  
advertise it here, 

E-mail me at 
editor@lcace.org 

TIME TO RENEW 
 
If it is time for you to renew your membership, 
please fill out a new Application and a Mem-
ber’s Profile Sheet. These forms can be obtained 
at the meetings or downloaded from our WEB 
site. 

 
Take a 

good look, 
you just 

might see 
LCACE CLUB PICTURES at: 

http://lcace.org/PhotoAlbums.htm 

 
Barnett, Fred ……………………………...…...BNSCom.aol.com 
Busch, Linda……...……………………….lindashrub@juno.com 
Bermah, Janet……………………….….jgiftofgrace@yahoo.com 
Ehlert, Rodger D………….……………..rehlert2@sbcglobal.net 
Frost, Jack…………………………………..Jfrost@megsinet.net  
Frost, Winnie……………… ……………….jfrost@megsinet.net 
Galla, Sue Ann……………...…………...villesuzie@warpnet.net 
Grauzas, Lawerance ………………………...MrG2156@aol.com 
Grimm, Phil………………… …………..pgrimm4@comcast.net 
Halley, Jack……………………………………..jack96@aol.com 
Hanlon, Terri……..……………………...terhanlon@comcast.net  
Horvath, M.S……………………………….Horvath2@msn.com 
Johnson, J.J……...…………………..…. jj1450xl@megsinet.net  
Kalinoski, Donna L……………….……….donnaleek@juno.com  
Korell, Keith K…………………………...kkorell@sbcglobal.net 
Mitchell, Earl G……………….……………egm1705@juno.com 
McDonald, Mark J…………………………markym36@aol.com  
McEnery, Mike…………………….....mmcenery@sbcglobal.net 
Nabors, John…………………………………….Jog@nomad.net  
Nordstrom, Lee & Mary…...………..…..LeeNord@earthlink.net  
Prange,Terry…………………………...…….tprange@juno.com 
Rivera, Julio & Lourdes...................…….jlrevera@db3mail.com 
Rutledge, James W………………………..jrutnet1@comcast.net 
Schintgen, Paul………………………………patys@theramp.net 
Seidenberg, Lew ………………………...…….drlew1@aol.com 
Seidenberg, Robin …………………….….anguslechat@aol.com 
Shaughnessy, Howard & Diane ……….………olisha1@aol.com  
Straw, Gerald……………………….……..gkstraw@comcast.net 
Sutherland, Dorothy………….….…dorothy4263@sbcglobal.net 
Swiezer, Edward…………………………...ednjen11@juno.com  
Tuttle, Bob……………………………….btuttle12@comcast.net 
Vogt, Grace……………………………….g.vogt@sbcglobal.net 
Wilson, Dennis ………………………….dcwilson@exexpc.com  
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Video / CD Video / CD Video / CD    
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Learning IllustratorLearning IllustratorLearning Illustrator   
Power Point  XPPower Point  XPPower Point  XP   

Digital Photography Digital Photography Digital Photography --- The Easy Way The Easy Way The Easy Way   
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LCACE 
Lake County Area Compuer Enthusiasts 
409 S. Elmwood Ave. 
Waukegan, IL 60085-5219 

ADDRESS CORRECTION REQUESTED 

LCACE Online 
View our Site 
http://www.lcace.org 

 
E-Mail Us At: 

 
webmaster@lcace.org 

 
Sign the Guest Book and tell us what you think 
♦ LCACE E-mail addresses 
♦ LCACE information  
♦ LCACE history and pictures 
♦ LCACE meeting, location, and map 
♦ LCACE member’s  e-mail addresses 

NEXT MEETING 
 

April 9, 2005 
 

Grayslake Public Library 
 

12:30pm—3:00pm 
 

Meeting Room Opens at Noon 
 

This month: 
INFINA DYNE DEMO 

(Club Elections 2005-2006) 


